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CI/EDLD 620 Qualitative Research | Autumn 2013 

Feel free to contact me: Kate Zoellner, Education, Human Sciences, and Psychology Librarian 
243-4421 or 800-240-4939 | kate.zoellner@umontana.edu | MLIB 325 

Office Hours: Wednesday 1-3pm and by appointment 
Online Research guides: 

http://www.lib.umt.edu/data_by_subject 
 
 

This Workshop Supports the following course objectives: 
• Analyze research abstracts and determine the specific type of research design presented in the study.	
  
• Utilize electronic databases to support a qualitative research proposal.	
  

 
 

KEY LIBRARY SERVICES FOR GRADUATE STUDENTS 

• Interlibrary Loan http://www.lib.umt.edu/ILL 
• Document Delivery http://www.lib.umt.edu/DocDel 
• Study Carrels http://www.lib.umt.edu/forms/carrel/carrel.php 
• Bibliographic Management Software – EndNote Basic and RefWorks 
• Workshops http://libguides.lib.umt.edu/workshops 
• Distance Education Library Services http://libguides.lib.umt.edu/dels 

	
  
	
  
LITERATURE REVIEW 
In reviewing the published literature, the aim is to explain what ideas and knowledge have been gained and shared 
to date (i.e., hypotheses tested, scientific methods used, results and conclusions), the weakness and strengths of 
these previous works, and to identify remaining research questions: A literature review provides the context for your 
research, making clear why your topic deserves further investigation. 
 
Boote and Beile (2005) provide the following explanation: 
 

As the foundation of any research project, the literature review should accomplish several important 

objectives. It sets the broad context of the study, clearly demarcates what is and what is not within 

the scope of the investigation, and justifies those decisions. It should not only report the claims 

made in the existing literature but also examine critically the research methods used and better 

understand whether the claims are warranted. Such an examination of the literature enables the 

author to distinguish what has been learned and accomplished in the area of study and what still 

needs to be learned and accomplished. Moreover, this type of review allows the author not only to 

summarize the existing literature but also to synthesize it in a way that permits a new perspective. 

Thus a good literature review is the basis of both theoretical and methodological sophistication, 

thereby improving the quality and usefulness of subsequent research. (p. 4) 

 
From: Boote, D. N., & Beile, P. (2005) Scholars before researchers: 

On the centrality of the dissertation literature review in research preparation. Educational Researcher, 34(6), 3-15. 
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RESEARCH STRATEGIES 

Plan 
Before you begin entering terms in a database, I recommend you follow the first five steps below: 

1. Understand your research question. 
2. Identify the major concepts in your question. 
3. Identify potential terms to correspond to those concepts.* 
4. Select alternative terms (narrower, broader, or related) to use if original strategy needs help. 

a. In ERIC use the Thesaurus of ERIC Descriptors; in PsycINFO use Thesaurus of Psychological Index Terms. 
5. Determine logical (Boolean) relationships between terms.** 
6. Begin the search. 
7. Look at a few documents. 
8. Revise & refine search based on initial results.*** 

 
From: Walker, G., & Janes, J. (1999). Online retrieval: A dialogue of theory and practice (2nd ed.). Englewood, CO: Libraries Unlimited. 

 
* Identify the potential terms that represent the concepts of your research question. 
** Determine logical (Boolean) relationships between terms. Boolean operators include: and, or and not. 

 
Break	
  down	
  the	
  research	
  statements	
  into	
  key	
  concepts	
  and	
  synonyms.	
  

Show	
  how	
  you	
  would	
  logically	
  combine	
  the	
  terms.	
  

 
 I want to find information on partnerships with parents in rural schools. 
 
 
 
 I’m looking for information on legislation that affects educators in Montana. 
 
 
 

 

*** Revise and refine your search based on the results you retrieve. 

Too many sources Not enough sources Sources not available at 
the Mansfield Library 

  ---Ask your professor or 
librarian for assistance in 
locating locally available 
materials 
 
---Request items via Interlibrary 
Loan: 
http://www.lib.umt.edu/ILL 
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Quick Tips for Searching ERIC – Using Descriptors  
ERIC has a standardized list, or controlled vocabulary, of education-related terms called Descriptors that are 
maintained in the Thesaurus of ERIC Descriptors. ERIC uses Descriptors to organize materials in the ERIC 
Collection by subject. Using Descriptors in your search can help you locate materials of greater relevance to your 
topic. Consider the following tips to guide your searches of the ERIC Collection from the ERIC Web site.  

Tip 1: Locate a Descriptor. There are three ways to identify relevant terms: 

x Access the Thesaurus using the link available on each page of the ERIC Web site. You can locate a 
Descriptor by searching the Thesaurus, browsing an alphabetical list of terms, or browsing a list of 
categories to see related Descriptors. Select a Descriptor to start your search.  

x On either the Basic or Advanced Search form, choose Descriptors from the drop-down list, click the 
Thesaurus button to access the Thesaurus search screen, and submit a search term, e.g., reading. 
ERIC will retrieve a list of terms containing the word(s). Clicking on a term provides a description. 

x Review your initial search results and select the information icon next to a Descriptor of interest to view 
details about the term, e.g., scope note or number of records indexed with the term. 

Tip 2: Develop a search using Descriptors. The search results will be more satisfying because you will: 

x Bypass irrelevant records: Use Descriptors to focus the search on your primary subject, not just the 
appearance of a word in the bibliographic record. For example, literacy may be mentioned in the record, 
but the focus of the material may be a different topic. Notice the different in results when searching the 
term literacy, first as keyword and then as Descriptor:  

Search String Number of Results* 
Keyword: literacy  ~52,500 
Descriptor: literacy  ~10,500 

* Results reflect database content as of March 2012. 

Records can also be irrelevant when a keyword has multiple meanings. For example, printing can occur 
in a document related to printing as an occupation, handwriting, visual arts, etc. Use the appropriate 
Descriptor to locate relevant materials. Notice the difference in results:  

Search String Number of Results* 
Keyword: Printing ~10,800 
Descriptor: Printing (used for the occupation) ~700 
Descriptor: Handwriting ~775 

* Results reflect database content as of March 2012. 

x Locate highly relevant records: Use Descriptors to locate materials relevant to a topic or concept, not 
just those that include the keywords. For example, the keyword phrase "parent education level" locates a 
few relevant materials about the topic. However the Thesaurus directs you to use a combination of terms 
to locate relevant materials. Notice the difference between results of the previous keyword search, and a 
search of the Descriptors "educational attainment" and "parent background": 

Search String Number of Results* 
Keyword: "parent education level" ~30 
Descriptors: “educational attainment” and “parent 

background” 
~375 

* Results reflect database content as of March 2012. 

Learn More About Searching ERIC – For more information on using the Thesaurus, searching the ERIC Collection, 
and understanding search results, visit the Help section at www.eric.ed.gov. 
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PRINT

73 new postable or "preferred" terms

51 new nonpostable or "used for" cross-referencing terms

13 new status changes

Includes more than 8,200 standard and cross-referenced terms.

New terms are mapped back to all relevant records in APA's databases spanning all years.

Scope notes define the terms.

Historical notes include information about the historical usage of terms since their introduction.

Term hierarchies show the relationship to other terms.

Posting notes tell how many times the term has been used in APA database records when the Thesaurus was published.

The year indicates when the term was added to the Thesaurus.

Order the Eleventh Edition (2007) of the Thesaurus of Psychological Index Terms now (/pubs/books/3100084.aspx)

Read introductory material from the Thesaurus of Psychological Index Terms (/pubs/databases/training/thesaurus-intro.aspx)

TweetTweet 0

PsycLIT® Training Center

Database Documentation

Thesaurus of Psychological Index Terms®

(/pubs/books/3100084.aspx) Eleventh Edition released June 15, 2007

Order now (/pubs/books/3100084.aspx)

What's New in the 2012 Update
Updated Terms Now Available (PDF, 26 KB) (/pubs/databases/training/thesaurus-term-updates.pdf)

What Are Index Terms?
Index terms are controlled vocabulary terms used in database records to make searching easier and more successful. By standardizing the words or phrases used to represent
concepts, you don't need to try and figure out all the ways different authors could refer to the same concept. Each record in APA's databases contains controlled vocabulary terms from
the Thesaurus of Psychological Index Terms®.

APA staff index records according to the source document's level of specificity. For example, an experimental population labeled "high school students" will be indexed with the term
"High School Students", not the broader and less specific term "Students". Therefore, any relevant narrower terms should be included in the list of index terms in your search. Related
terms may also closely match a search topic, and should be considered as well.

 

Why is a Controlled Vocabulary Essential for Searching?
With the wide variety of concepts and vocabulary used in the psychological literature, search and retrieval of records about specific concepts is virtually impossible without the
controlled vocabulary of a thesaurus. This controlled vocabulary provides a way of structuring the subject matter in a way that is consistent among users (e.g., searching for Dysphoria,
Melancholia, and Depression can all be achieved by searching the term "Major Depression").

 

Online Thesaurus Searching

Each PsycINFO® vendor labels the index terms field differently, and some vendors include an online Thesaurus, so check the search help for the search system you are using to see
how to search using index terms. If we have a search guide (/pubs/databases/training/search-guides.aspx) for your system, you'll also find the information there.

Please visit our Field Guide (/pubs/databases/training/field-guide.aspx) for more details on other fields in PsycINFO records.

 

Thesaurus Features

Related Links

If you have feedback or want to suggest new terms, please email PsycINFO (mailto:psycinfo@apa.org) .

Like 4 ShareShare

http://www.apa.org/pubs/databases/training/thesaurus.aspx
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RESEARCH RESOURCES 
Access all library electronic resources via the library web site. Select the “Databases, A-Z” link from the homepage. 
If you are off-campus, you will need to login to the library’s system with your NetID and password to access these proprietary databases. 
	
  
Index Strengths Details 

Dissertations & Theses, 
ProQuest Digital 
Dissertations Abstracts 
International (DAI) and 
Masters Abstracts 
International (MAI) 

1861-present 
 
Advanced Search; 
Command Line; Search 
limit options (e.g., Advisor, 
School name) 

Nearly 3 million dissertations and theses citations from around 
the world (ProQuest estimates that “95% to 98% of all U. S. 
doctoral dissertations are included”) 
 
Over 1.2 million available for download in PDF format; most 
of the dissertations added since 1997 are available in full text 
 
See also the University’s Electronic Thesis, Dissertation and 
Professional Paper Project (ETDP) http://www.lib.umt.edu/etd 

ERIC 
(Education Resources 
Information Center) 
Resources in Education 
(1966-2002) and Current 
Index to Journals in 
Education (1969-2002), 
as well as the 13th 
edition of the Thesaurus 
of ERIC Descriptors 

1966-present 
 
Advanced Search; 
Command Line Search; 
Search limit options (e.g., 
Document type, Education 
level); Figures & Tables; 
Thesaurus Search 

Over 1.4 million records covering Adult, career and vocational 
education; Counseling; Elementary and early childhood 
education; Education management; Higher education; Junior 
colleges; Second-language learning; Special education; Teacher 
education; and Tests, measurement and evaluation 
 
Indexes journal articles, conference papers, meetings, 
government documents, theses, dissertations, reports, 
audiovisual media, bibliographies, curriculum and teaching 
guides, directories, books and monographs 

Educational 
Administration 
Abstracts 

1966-present 
 
Advanced Search; Search 
limit options (e.g., 
scholarly/peer-reviewed) 

Over 199,000 records covering areas related to educational 
administration, including educational leadership, educational 
management, and educational research 
 
Indexes journal and magazine articles 

PsycINFO 
Thesaurus of Psychological 
Index Terms 

1890-present 
 
Advanced Search; 
Command Line Search; 
Search limit options (e.g., 
Methodology, Age Group); 
Thesaurus search 
 
Some cited reference data 

Over 2.8 million records covering all areas of psychology, 
behavioral sciences, and related disciplines: Applied 
psychology; Communication systems; Developmental 
psychology; Educational psychology; Experimental human and 
animal psychology; Personality; Psychological and physical 
disorders; Physiological psychology and neuroscience; 
Professional personnel and issues; Psychometrics and statistics; 
Social psychology; Social processes and issues; Sports 
psychology and leisure; and Treatment and prevention 
 
Indexes professional journals, chapters, books, reports, theses 
and dissertations 

Web of Knowledge/ 
Web of Science 
Social Sciences Citation 
Index (1898-present), 
Science Citation Index 
(1900-present), and 
Arts & Humanities 
Citation Index (1975-
present) 

Coverage dates vary by 
Index 
 
Advanced Search; Cited-
reference Search; Citation 
Report; Citation Map 
 
Times Cited data 

The Social Sciences Citation Index contains roughly 7.8 million 
records; covers 5,300 publications from 55 social science 
disciplines 
 
Indexes journals and conference proceedings 
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ERIC 
 

qualitative	
  |	
  keyword	
  AND	
  leadership	
  |	
  keyword	
  
 

Thesaurus descriptors for qualitative, and related terms? 
 
 
Thesaurus descriptors for leadership, and related terms? 
 
 
 

	
  
PsycINFO 

 

autism	
  |	
  keyword	
  AND	
  intervention	
  |	
  keyword	
  AND	
  schools	
  |	
  keyword	
  
 

Thesaurus descriptors for autism, and related terms? 
 
 
Thesaurus descriptors for intervention, and related terms? 
 
 
Thesaurus descriptors for schools, and related terms? 
 
 
 

 
Web of Knowledge/Web of Science (cited reference search) 
If you want to know who has cited a specific article, you can find out by searching Web of Knowledge/Web of Science or 
Google Scholar. PsycINFO began adding cited reference in 2001 and will continue to add retrospective coverage. 
 

Scribner,	
  J.,	
  Cockrell,	
  K.,	
  Cockrell,	
  D.,	
  &	
  Valentine,	
  J.	
  (1999).	
  Creating	
  professional	
  communities	
  in	
  schools	
  through	
  
organizational	
  learning:	
  An	
  evaluation	
  of	
  a	
  school	
  improvement	
  process.	
  Educational	
  Administration	
  Quarterly,	
  
35(1),	
  130-­‐160.	
  
 

How many times has the article been cited in Web of Science? 
 
In Google Scholar? 
 

 
Locate a Specific Journal or Journal Article 
If you are looking for a specific article (e.g., from a reference list) or a specific journal, the first step is to find out if 
the library subscribes to that journal. Enter the name of the journal in the main search box on the library homepage, 
then choose Journal Titles from the Search In pull-down menu. This will show you if the library provides access to 
the journal in a database, in UM Print Holdings, or indicate that the library does not subscribe to the journal. If the 
library subscribes to the journal, be sure to check the dates of coverage that are available. If the library does not 
have a subscription to the journal or only a paper copy you can request specific articles from the journal via 
Interlibrary Loan or Document Delivery (http://www.lib.umt.edu/services/request-material). 
 
 

Davis,	
  S.,	
  &	
  Nixon,	
  C.	
  (2011).	
  What	
  students	
  say	
  about	
  bullying.	
  Educational	
  Leadership,	
  69(1),	
  18-­‐23.	
  
 

Does the library provide you access to the title?                 If not, how can you access the article? 
 

If so, can you access the article online via the library databases? 
 

If so, can you access the article in print in the library? 
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If you want to know what journals are highly regarded in your field of study, one measure is impact factor. You can 
locate journals with high impact factors in the database Journal Citation Reports. For each journal you will see 
how many articles were published in it, how many times articles from the journal were cited, a one-year and five-
year impact factor ranking, and additional metrics. Note that JCR does not cover all published journals. Also note that 
the increased sharing of research online via blogs, faculty websites, institutional repositories, etc., has led individuals 
to develop alternative metrics for measuring scholarly impact (e.g., http://altmetrics.org/manifesto/). For guidance 
on where to publish see Cabell’s Directories (of Publishing Opportunities). 
 
Open Access Literature 
Open-access (OA) literature is digital, online, free of charge, and free of most copyright and licensing restrictions. 
OA is a kind of access, not a kind of business model, license, or content. OA is compatible with copyright, peer 
review, revenue (even profit), print, preservation, prestige, quality, career-advancement, indexing, and other features 
and supportive services associated with conventional scholarly literature. The primary difference is that the bills are 
not paid by readers and hence do not function as access barriers. 
 
The legal basis of OA is the consent of the copyright holder (for newer literature) or the expiration of copyright (for 
older literature). Because OA uses copyright-holder consent or the expiration of copyright, it does not require the 
reform, abolition, or infringement of copyright law. The campaign for OA focuses on literature that authors give to 
the world without expectation of payment. Many OA initiatives focus on publicly funded research. 
 
OA is compatible with peer review, and all the major OA initiatives for scientific and scholarly literature insist on its 
importance. The chief difference between them is that OA journals conduct peer review and OA repositories do 
not. This difference explains many of the other differences between them, especially the costs of launching and 
operating them. 

From: Open Access Overview, Peter Suber, http://www.earlham.edu/~peters/fos/overview.htm 
 
A few resources: 

• American Educational Research Association Online Paper Repository 
http://www.aera.net/Publications/OnlinePaperRepository/tabid/10250/Default.aspx 
“An open access clearinghouse, with abstracts, of all scientific presentations given at AERA annual meetings 
since 2010. More than half include full-text papers voluntarily contributed to the repository by annual 
meeting presenters. AERA encourages all presenters to make their full-text papers available to the repository 
as a way to distribute their research more broadly.” Requires site registration. 

• DOAJ (Directory of Open Access Journals) http://www.doaj.org/ 
Directory of open access scientific and scholarly journals that publish scholarly or review articles; exercise 
peer-review or editorial quality control; and are from academic, government, commercial, or non-profit 
private sources. DOAJ is hosted and maintained by Lund University Libraries, Sweden. 

 
 

KEEP CURRENT 
Current Awareness Services help you keep on top of what is being published in your research area, or by specific 
authors or in specific journals, by automating research practices. These services are provided free by most 
publishers and database vendors, and some search engines; often they require registration. You can select how often 
to be updated (e.g., monthly) and how, usually options are via email or a RSS feed. Here are a few details: 

• Table of Contents Alerts. Receive an alert each time a new issue of a journal is published. (JournalTOCs is a 
website service through which you can sign up for multiple alerts http://www.journaltocs.hw.ac.uk/.) 

• Saved Search Alerts. Receive notice when new articles come into a database that fit your search query. 
• Cited Reference Alerts. Receive notice when a new publication cites a particular article or text. 
• News alerts. Receive alerts from newspapers, government institutes, etc.; anywhere you see the RSS icon. 
• Google and Yahoo! Alerts. Set up a search query and have the results emailed to you. 

  



page 8 

MANAGE YOUR RESEARCH 
Citation Management Software can help you manage your research and format citations. You can use citation 
management software to: create your own personal database to keep track of your research articles, documents, 
websites, etc.; import citation information from a variety of resources into your database; automatically generate a 
bibliography in a variety of styles (e.g., APA, ASA, Chicago, MLA); and add in-text citations to a paper in a variety 
of styles. The two web-based tools the library provides are EndNote Basic and RefWorks. The table below 
provides basic information to get you started using either EndNote Basic or RefWorks. Find our more at: 
http://libguides.lib.umt.edu/endnoteweb and http://libguides.lib.umt.edu/refworks. 
	
  
	
   EndNote	
  Basic	
   RefWorks	
  

Access	
   Via the “Databases, A-Z” link on the homepage. Via the “Databases, A-Z” link on the homepage. 

Capacity	
   50,000 references; top 3,300 bibliographic styles Unlimited references; 800 bibliographic styles 

Set	
  up	
  an	
  
account	
  

Requires the use of your official UM email 
address. Your password must include at least 
one letter, number, and symbol. No special code 
is required for off-campus access but you need 
to initially register for an account from an on-
campus location. 

Requires the use of your official UM email 
address. Off-campus access requires a Group Code 
that will be sent to you when you set up your 
account and can be re-sent to you if you send an 
email from your university account to 
refworks@umontana.edu. 

Add	
  
citations	
  

Manually under the “Collect” menu, “New 
Reference.” Export data from various databases, 
usually under “Export” or “Save Citations.” In 
some instances this is seamless (e.g., using Web 
of Science), in other instances you need to 
download the data and then use the “Import 
References” option under the “Collect” menu. 

Manually under the “References” menu, “Add 
New” or via the “New Reference” button. 
Export data from various databases, usually 
under “Export” or “Save Citations.” In some 
instances this is seamless (e.g., using CSA 
databases), in other instances you need to 
download the data and then use the “Import” 
option under the “References” menu to add the 
reference data. 

Organize	
  
citations	
  

Use the “Organize” menu, “Manage My 
Groups”, to group references into folders by 
topic, project, etc. A citation can be placed in 
more than one folder. Folders can be shared 
with other EndNote Web account holders. 

Select the “New Folder” button. A citation can 
be placed in more than one folder. Select the 
“Organize & Share Folders” tab to make 
changes. Folders can be shared with RefWorks 
and non-RefWorks account holders via email, 
URL, or in UM’s RefWorks RefShare area. 

Find	
  
citations	
  in	
  
your	
  account	
  

Use the “Quick Search” menu on the “My 
References” page. 

Use the “Search” box. Citations can also be 
sorted in a number of ways such as by author, 
title, and journal. 

Create	
  
in-­‐text	
  
citations	
  

Requires you to download the “Cite While You 
Write” plug-in for your computer that works 
with MS Word programs on PC and Mac 
applications. Find the utility under the “Format” 
menu – “Download Installers.” 

Requires you to download a utility program to 
your computer called “Write-N-Cite” that works 
with MS Word programs on PC and Mac 
applications. Find the utility under the “Tools” 
menu. 

Bibliography	
   Under the “Format” menu choose 
“Bibliography.” 

Use the “Bibliography” menu or the “Create 
Bibliography” button. 

Get	
  help	
   Tutorials are available at 
http://www.youtube.com/user/EndNoteTraini
ng; “Help” menu and “Getting Started Guide”. 

Tutorials are available at 
www.youtube.com/proquestrefworks; “Help” 
menu. 

	
  


